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Merci d’avoir choisi MIXVIBES


  HOME EDITION. Pour toutes vos questions, vous 

trouverez de l’aide et des conseils, en plusieurs langues, sur le forum MIXVIBES


  à 

l’adresse : www.mixvibes.com/forum. 

 

Ce guide a pour but de présenter en détails les fonctionnalités de MIXVIBES
 ainsi 

que son utilisation. Prenez le temps de lire ces quelques pages d’explications, elles vous 

permettront de prendre, plus rapidement, le logiciel en main. 

 
Configuration minimum requise pour utiliser MIXVIBES


  HOME EDITION : 

 
- Système d’exploitation : Windows® NT, 2000, XP ou Vista 
- Processeur Intel® Pentium III 500 MHz ou équivalent 
- 512 MO de mémoire RAM 
- Carte son compatible DirectX 
- Lecteur CD-ROM 
- 15MO d’espace disque 
- Souris compatible Microsoft® 
- Clavier 
- 1 port USB non utilisé (pour la carte son USB fournie) 
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Chapitre 1 : Installation 

 
A. Installation du logiciel 

 

Insérez le CD-ROM MIXVIBES

 HOME EDITION dans le lecteur CD de votre ordinateur. 

Si la procédure d’installation de démarre pas automatiquement, ouvrez l’explorateur 

Windows et double-cliquez sur le fichier « install.exe » à la racine du CD-ROM. 

 

Le CD-ROM est un format 80mm, assurez-vous que votre lecteur accepte ce type de 

support avant de l’y insérer. Vous pouvez en particulier rencontrer des problèmes 

avec des lecteurs de type « mange disque ». 

 

1. Choisissez la langue d’installation puis validez 

en cliquant sur OK.  

 

 

 

2. Lisez et acceptez les termes de la licence 

MIXVIBES en cliquant sur Accept. 

 

 

  

3. Entrez vos nom (Name), entreprise 

(Company) et e-mail ainsi que le code 

d’activation que vous trouverez dans la boîte 

du logiciel puis cliquez sur Next. 

 

4. Choisissez le répertoire d’installation ou 

laissez celui par défaut : « C:\Program 

Files\MixVibesHOME ». Cliquez sur Next. 

L’espace requit est inférieur à 15Mo. 

 

5. Cliquez sur Finish pour quittez l’assistant 

d’installation. 

 

 

 

 

 

    Félicitations, votre MIXVIBES


 HOME EDITION est à présent installé  

   et prêt à être utilisé. 
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B. Installation de la carte son USB 

 

Avant de continuer, assurez vous d’avoir en votre possession cette carte son USB 

MIXVIBES


 et de disposer d’un port USB inutilisé sur votre ordinateur. 

 

 

 

 

 

 

 

Cette carte son, au format d’une clé USB, ajoute une sortie audio à votre ordinateur, 

vous permettant, entre autres, de profiter de la pré-écoute1 lors de vos mixes. 

 

Brancher la carte son MIXVIBES


 dans un port USB inutilisé de votre ordinateur : 

 

6.   

 

 

 

 

Windows® la détecte automatiquement. 

 

7.   

 
 

 

 

 

 

 

 

 

 

 

 

 

Laissez Windows® installer automatiquement le logiciel en cliquant sur Suivant. 

 

 

                                                

 

 
1 Consiste à pré-écouter au casque, tout en continuant son mix, une musique que l’on s’apprête à jouer, ceci 
dans un but de préparation (la réussite des enchaînements en dépend souvent !). 
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8.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Windows® recherche le pilote adapté... 

 

9.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

...puis copie les fichiers nécessaires. 
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10.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Votre nouveau périphérique audio est maintenant installé. Cliquez sur Terminer. 

 

11.   

 

 

 

 

 

 

Windows® vous confirme que l’installation s’est bien déroulée, vous pouvez 

désormais utiliser la carte son MIXVIBES


  (voir p.41 pour une utilisation en pré-

écoute). 
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Ecran du 
lecteur 

(voir p.12) 

3333    
 

4444    
= 

6666    
= 

2222    

    
= 

1111    
= 

5555    

    
= 

9999    
= 

10101010    
= 

11111111    
= 

8888    = 

7777    = 
15151515    = 

13131313    = 
14141414    = 12121212    = 

Tranche de console 
(voir p.19) 

Chapitre 2 : le lecteur MIXVIBES


   
 

A. le lecteur MIXVIBES


     en détails 

 

 Le lecteur MIXVIBES


  : 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

Choisir le média. 

1. Charger un média : ouvre une boîte de dialogue qui permet de choisir le fichier du 

média à charger. 

2. Média suivant/précédent : permet de charger le média suivant/précédent de la 

médiabase dans le lecteur. 

 

Jouer le média. (voir p.13) 

3. Lecture/Pause : permet de lancer la lecture du média ou de l’arrêter (en gardant 

la position de lecture). 

4. Cue / Stop : permet de gérer le point cue et de stopper la lecture (arrêt avec 

retour au point cue). 

5. Répétition : active/désactive la lecture répétée. 

 

Se positionner dans le média. (voir p.14) 

6. Recherche accélérée avant/arrière. 

7. Jog wheel. 

 

Gérer les localisations. (voir p.16) 

8. Localisations 1 à 6 : accès au 6 localisations disponibles. 

 

Gérer les boucles. (voir p.16) 

9. Début de boucle : Permet de définir l’instant d’entrée de la boucle. 
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10. Fin de boucle : Permet de définir l’instant de sortie de la boucle. 

11. Boucle On/Off : Permet d’activer ou de désactiver la lecture de la boucle. 

 

Vitesse, Master Tempo et Tonalité. (voir p.17) 

12. Curseur de vitesse / tempo / tonalité : modifie la vitesse, le tempo ou la tonalité 

en fonction du mode choisi. 

13. Mode du curseur : Permet de choisir le paramètre sur lequel le curseur agit, 

vitesse, tempo ou tonalité. 

14. Incrémentation du curseur : Permet de diminuer ou d’augmenter le paramètre 

associé au curseur (clic droit) ou de faire un pitch bend2 (clic gauche). 

15. Remise à zéro du curseur : Permet de réinitialiser (remettre à zéro) le paramètre 

associé au curseur. 

 

 Ecran du lecteur MIXVIBES


  : 

 

 

 

 

 

     

 

 

1. Numéro du lecteur : allumé ( ) si lecteur actif, éteint ( ) sinon. 

2. Statut du lecteur : utilisé  �  / inutilisé  � . 

3. Nom du média chargé dans le lecteur : « auteur – titre » si disponibles. 

4. Forme d’onde : défile avec la lecture, permet de « visualiser » le média lu. 

5. Temps écoulé (entre le début du média et la position courante). 

6. Temps restant (entre la position courante et la fin du média). 

7. Barre de recherche : Permet de visualiser la position courante par rapport au 

média complet et de se positionner dans le média en cliquant et/ou déplaçant le 

curseur noir. 

8. Position courante (tête de lecture). 

9. Point cue. 

10. Localisation n° 1 (6 localisations disponibles). 

11. Point d’entrée de la boucle. 

12. Point de sortie de la boucle. 

13. Tempo initial (estimé par MIXVIBES


  ou donné par l’utilisateur). 

14. Tempo courant (tient compte des modifications apportées par le curseur 

vitesse/tempo/tonalité). 

15. Valeur du curseur vitesse/tempo/tonalité.    
16. Valeur du pitch bend2. 

                                                

 

 
2 Modification temporaire du paramètre vitesse / tempo / tonalité à l’aide du jog wheel ou des boutons -/+. 

13131313    
= 

14141414    
= 6666    

 
5555    
= 

3333    
= 

9999    
= 

8888    = 

15151515    
 

7777    
= 

11111111    
= 

12121212    
= 

10101010    = 

4444    

    
= 

2222    
= 

1111    
= 

16161616     
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B. Utiliser un lecteur MIXVIBES
  

 

1. Charger un média 

 

Glissez-déposez3 le fichier correspondant à votre média (ex. un fichier audio au format 

MP3) depuis l’explorateur sur le lecteur de votre choix (lecteur 1 par exemple, celui de 

gauche). L’icône  vous informe que vous pouvez y déposer le fichier. Remarquez que 

le média chargé s’ajoute automatiquement à la médiabase (voir p.25) s’il n’y est pas 

déjà.  

 

Par défaut, le chargement du média s’accompagne de son analyse, à savoir calcul des 

pics (peaks) et estimation du tempo moyen (BPM). MIXVIBES


 se charge aussi de 

positionner automatiquement le point cue (voir p.15) au début du média. Ces deux 

options de chargement peuvent être paramétrées et/ou désactivées dans les options de 

MIXVIBES
 
( >Mix ou menu File>Options>Mix). Dès lors, votre média est prêt à 

être joué.  

 

2. Jouer un média 

 

Un lecteur MIXVIBES
 

propose les mêmes contrôles que n’importe quel lecteur 

multimédia (voir p.11). 

                                                

 

 
3 Il existe d’autres manières de charger un média dans un lecteur mais le glisser-déposer depuis l’explorateur 

reste la plus directe. 
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Cliquez sur lecture/pause  pour démarrer la lecture de votre média à partir du point 

cue défini automatiquement par MIXVIBES
 
(voir p. 15).  

 

Cliquez sur le bouton repeat  →  pour activer la lecture répétée : lorsque la fin 

du média est atteinte, la lecture recommence automatiquement au début. 

 

Cliquez une nouvelle fois sur lecture/pause  si vous désirez stopper la lecture de 

votre média. Notez que la position de lecture est conservée. Le retour au début se fait 

soit à l’aide du bouton cue  , soit à l’aide du bouton média précédent . 

 

3. Se positionner dans le média 

 

Le lecteur MIXVIBES


 permet de se positionner précisément dans un média. Vous 

pouvez utiliser, au choix : 

 

 les boutons de recherche accélérée (search)  

-  avant, 

-  arrière.  

Un clic sur l’un de ces boutons décale la tête de lecture d’une durée égale à quatre temps 

(beats) si le tempo estimé par MIXVIBES

 est différent de 0 et d’une durée de 2 

secondes sinon.  

 

 le jog wheel qui permet des décalages à la milliseconde près vers l’avant si on le 

tourne dans le sens des aiguilles d’une montre, vers l’arrière dans le sens inverse. 

 

 

C. Fonctions avancées du lecteur 

 

Les fonctions introduites précédemment permettent une utilisation simple et 

relativement basique d’un lecteur MIXVIBES


 , cette nouvelle partie a pour but de vous 

familiariser avec des fonctions plus avancées qui vous permettrons de pimenter vos 

mixes. 

 

1. Fonctions cue, localisations (locations) et boucle (loop) 

 

Découvrons à présent quelques fonctions, couramment utilisées par les DJ, qui 

permettent de personnaliser la lecture d’un média en contrôlant sa position de lecture. 
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 Fonction cue 

 

Cette fonction permet, à tout moment, de déplacer la tête de lecture du 

lecteur à une position précise préalablement définie (le point cue).  

 

Chargez un média dans un des lecteurs (ex. : utilisez le glisser-déposer). 

Remarquez l’affichage de la forme d’onde du média dans l’écran du lecteur, ainsi que le 

marqueur , qui repère le point cue, par défaut placé au début d’un média lors du 

chargement de ce dernier. ( >Mix ou menu File>Options>Mix pour en modifier les 

paramètres). 

 

 

 

 

 

 

• Pour changer la position du point cue, effectuez un clic droit sur 

 au moment précis où la tête de lecture atteint la position 

qui vous intéresse.  

• Au cours de la lecture d’un média, un clic gauche sur  a 

pour effet de mettre le lecteur en pause, en déplaçant la tête 

de lecture au point cue prédéfini. 

• Quand le lecteur est en pause, un clic gauche sur  lit le 

média chargé à partir du point cue tant que le bouton de la 

souris est maintenu enfoncé. La tête de lecture se repositionne 

ensuite au point cue, lecteur en pause.  
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 Utilisation des localisations (locations) 

 

Cette fonction permet d’enregistrer plusieurs repères de 

position (localisations). Remarquez, sur le visuel ci-

contre, que les repères disponibles sont au nombre de 

six. Ce nombre peut toutefois varier en fonction de 

l’habillage utilisé (voir p.42).  

 

Imaginons que vous souhaitiez pouvoir, instantanément, lire un média à partir 

d’un endroit précis, quelque soit l’état du lecteur (lecture en cours ou non).  

 

Commencez par placez la localisation  à l’endroit du morceau qui vous 

intéresse : un clic droit sur  associe la position courante à la localisation , cette 

manoeuvre est valable que la lecture soit en cours ou non.  

 

A tout moment, un simple clic gauche sur  déplace la tête de lecture au 

niveau de la localisation  sans changer l’état du lecteur (la lecture continue si elle était 

en cours).  

 

Vous pouvez de cette manière faire correspondre à chaque média jusqu’à six 

localisations différentes qui seront sauvegardées avec votre médiabase (voir p.25). 

 

 Créer une boucle (loop) 

 

Après les localisations, découvrons comment créer une boucle de son dans un 

média.  

  

 

 

 

 

 

 

  

Commencez par charger un média dans le lecteur, en vous assurant que le tempo 

du morceau (BPM) ait été trouvé. Positionnez la tête de lecture à l’endroit du morceau 

que vous souhaitez marquer comme entrée de votre boucle, puis cliquez sur  

(enregistrement de la position courante comme position de début de boucle). Remarquez 

que l’instant d’entrée de boucle est repéré par le marqueur  sous la forme d’onde.  

 

Afin de s’assurer que votre boucle soit calée sur le tempo, et reste ainsi 

« musicale », il faut définir précisément l’instant de sortie (fin de boucle) en fonction de 

l’instant d’entrée. Pour ce faire, à partir du début de la boucle, déplacez la tête de lecture 

à l’aide de la fonction avance rapide  dont le pas dépend du tempo (voir p.14).  
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Cliquez sur  pour définir l’instant de sortie (enregistrement de la position 

courante comme position de fin de boucle), celui-ci est repéré par le marqueur  sous la 

forme d’onde. 

 

Une fois les instants d’entrée et de sortie de boucle déterminés, la fonction 

boucle s’active automatiquement (  → ). Il ne vous reste plus qu’à lancer la 

lecture et apprécier la boucle que vous venez de créer. 

 

 Vous pouvez, si vous le souhaiter, sauvegarder les positions de début et de fin de 

boucle en utilisant les localisations (voir p. 14). 

 

Pour activer/désactiver la lecture en boucle, effectuez un clic gauche sur le 

bouton . Un clic droit sur  déplace la tête de lecture au début de votre 

boucle sans changer l’état du lecteur (lecture en cours ou non), et l’état de la lecture en 

boucle (active ou non). 

  

 

2. Vitesse, Master Tempo et Tonalité 

    

Afin de personnaliser vos mixes, MIXVIBES

 vous permet de contrôler la vitesse et 

la tonalité de chacun des médias joués dans les lecteurs. Chaque lecteur d’un curseur 

dédié à ces fonctionnalités. Par défaut, ce curseur est inversé comme sur les platines 

vinyles (« norme » pour les DJ). Lorsqu’on le pousse vers le haut la valeur diminue, vers 

le bas elle augmente. On peut retrouver un fonctionnement standard en modifiant les 

options de MIXVIBES

 (voir p.39).  

 

Un bouton à trois états (chaque clic le fait passer à l’état suivant) permet de choisir 

sur quel paramètre agit le curseur : 

-  ce mode (speed) permet d’obtenir le même effet qu’avec le curseur des 

platines vinyles. Il permet en effet de jouer sur la vitesse de lecture du média 

sans préserver la tonalité. Plus la valeur est élevée, plus le média est lu 

rapidement,  plus il sera aigu (comme lorsqu’un disque vinyle tourne trop 

vite). Dans le cas inverse, le média sera lu plus lentement et donc plus grave 

(comme lorsqu’un disque vinyle tourne trop lentement). 

-  ce mode (tempo) aussi appelé Master Tempo permet d’accélérer ou de 

ralentir un média sans toucher à sa tonalité. 

-  ce dernier mode (pitch ou key) permet de modifier la tonalité du média 

à vitesse constante. 

 

Dans les trois cas, la position centrale correspond au zéro et donc à une non 

modification du média. Le bouton  permet d’y revenir en un clic. 
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De plus si vous désirez affiner votre réglage, les boutons  vous permettent 

respectivement de diminuer et d’augmenter pas à pas la valeur du paramètre considéré 

(variation en pourcents pour vitesse/tempo ou demi-tons pour tonalité). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dans l’exemple, le tempo est augmenté de 6.9% par rapport à l’original. Remarquez le 

curseur inversé, vers le bas pour une valeur positive. 
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D. Tranche de console 

La partie droite d’un lecteur contient les éléments qui servent d’une part à calibrer le 

signal audio en entrée et d’autre part à adapter le signal audio en sortie avant qu’il ne 

soit mélangé avec celui de l’autre lecteur. Ces opérations sont courantes dès lors qu’on 

souhaite régler une piste sur une table de mixage. Ainsi nous appellerons cette partie du 

lecteur la « tranche de console ». 

 

1. Réglage du gain et fonction mute 

 

Lorsque vous enchaînez deux morceaux, vous souhaitez que le 

volume d’un média soit le même que celui du précédent, afin que 

l’enchaînement soit le plus fluide possible. 

 

Les fichiers audio que vous utilisez n’ont pas tous le même 

niveau. 

 

Pour réaliser un enchaînement fluide d’un lecteur vers le second, il 

vous faudra contrôler l’égalité des niveaux des deux lecteurs à 

l’aide de leur vu-mètre. Si les vu-mètres ne présentent pas la 

même amplitude de signal, corrigez la différence sur le 

potentiomètre de gain de l’un des deux lecteurs (préférez le 

second si le premier est en lecture). 

 

 

 

 Attention aux morceaux qui ne débutent pas à leur niveau maximal, le réglage du 

gain ne s’effectue pas sur les parties calmes ! 

 

Un clic gauche sur le bouton mute rend muet le lecteur. Un second clic le 

« réactive ». 

 

Un clic droit prolongé sur le bouton mute rend muet le lecteur jusqu’à ce que le 

bouton de la souris soit relâché.  

 

Un double clic sur le potentiomètre de gain le fait revenir en position centrale. 

 

2. Egalisation et suppression de fréquences 

 

Dans la tranche de console, vous avez également la possibilité d’agir sur le contenu 

fréquentiel du signal audio en provenance du lecteur.  

 

(1) : bouton mute 
(2) : Potentiomètre   

de gain 
(3) : vu-mètre  

(1) 

(2) 

(3) 
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Un égaliseur 3 bandes ainsi que 3 boutons de suppression de fréquences (frequency kills) 

sont mis à votre disposition pour retoucher l’égalisation du lecteur. Un double clic sur un 

potentiomètre le fait revenir en position centrale. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Un clic gauche sur le bouton bypass  permet d’activer/désactiver à tout moment les 

réglages d’égalisation et de suppression de fréquences. Un clic droit permet 

d’activer/désactiver ces réglages temporairement (tant que le bouton de la souris est 

pressé). 

 

De même, un clic droit prolongé sur un bouton de suppression de fréquences supprime 

les fréquences concernées jusqu’à ce que le bouton de la souris soit relâché. 

 

3. Volume et panoramique 

 

Sur la tranche de console de chaque lecteur vous trouverez 

également les réglages classiques de volume et de panoramique 

(balance gauche-droite pour la stéréophonie). 

 

Après avoir correctement réglé les gains en entrée, un DJ préférera 

doser le volume des lecteurs, l’un par rapport à l’autre, en utilisant 

le crossfader (voir p. 21), sans toucher au volume des tranches de 

console. 

 

 

 

4. Affectation de la sortie 

 

MIXVIBES
 vous donne la possibilité d’affecter à la sortie de chaque 

lecteur un périphérique audio différent. Le périphérique affecté est 

indiqué dans la tranche de console, pour le modifier il vous suffit de 

cliquer sur son numéro. Le détail des périphériques audio est donné 

dans le menu Fichier>Options>Sound. 

Réglage des aigus 
(5000Hz) 

Réglage des 
médiums (2000Hz) 

Réglage des 
basses (200Hz) 

Kill 9000Hz 

Kill 250Hz 

Kill 100Hz 

Egalisation 
Suppression 
de fréquences 
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Chapitre 3 : Mixage 
 

A. Mon premier mix avec MIXMIXMIXMIXVIBESVIBESVIBESVIBES

 

 

1. Les éléments nécessaires 

 

Pour mixer deux médias, deux éléments MIXVIBES


 sont indispensables : 

 

 le crossfader  

 

 

 

 

 

 

Cet élément reprend le principe du crossfader analogique que l’on trouve sur toutes  

les tables de mixage destinées aux DJ. Il permet  de doser le mélange entre les deux 

médias : 

- en position centrale, le mélange est composé à 50% de la sortie du lecteur 1 

et à 50% de la sortie du lecteur 2 ; 

- complètement à gauche (vers A), le mélange contient uniquement ce que joue 

le lecteur 1 ; 

- complètement à droite (vers B), le mélange contient uniquement ce que joue 

le lecteur 2 ; 

- en position intermédiaire vers la gauche, le mélange contient plus du lecteur 1 

que du lecteur 2 ; 

- en position intermédiaire vers la droite, le mélange contient plus du lecteur 2 

que du lecteur 1. 

 

Quatre boutons viennent compléter le crossfader traditionnel : 

- deux boutons de fondu (fade) qui permettent de faire passer automatiquement 

et progressivement le mélange : 

o soit de 100% lecteur 2 à 100% lecteur 1  (bouton de gauche), 

o soit de 100% lecteur 1 à 100% lecteur 2  (bouton de droite). 

 

 Le fade automatique joue directement sur le volume des lecteurs et non 

sur le crossfader. 

 

- deux boutons de synchronisation automatique du tempo (match) qui 

permettent de synchroniser : 

o soit lecteur 1 sur lecteur 2  (bouton de gauche),  

o soit lecteur 2 sur lecteur 1  (bouton de droite).  
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Cet outil combine, et rend accessibles à tous en un clic, deux tâches 

originellement effectuées manuellement par le DJ qui sont la mise au même 

tempo de deux médias4 (accélération / ralentissement) et leur synchronisation 

(calage temporel).  

 

Si l’option Auto Mix When press Auto Match Button  est désactivée 

(voir p.40), seule la première tâche est réalisée. 

 

 le rack auto-bpm  

 

 

 

 

 

 

Cet élément permet de visualiser simultanément les pics des deux médias joués 

et ainsi de contrôler visuellement leur synchronisation. En effet, des pics importants 

correspondent à un niveau sonore élevé dans le média et donc généralement à un 

beat (temps souvent marqué par un son de grosse caisse). Deux médias synchronisés 

auront leurs pics élevés « aux mêmes instants ». 

 

Les pics du média du lecteur 1 sont toujours affichés en bas (en noir) quand ceux 

du média du lecteur 2 sont toujours en haut et la tête en bas (en gris). 

 

Dans l’exemple présenté, on remarque que les deux média ne sont a priori pas 

bien synchronisés. 

 

 

Vérifiez que vous avez bien crossfader et rack auto-bpm à l’écran, sinon cliquez sur leurs 

icônes respectives pour les afficher (voir p. 44). 

                                                

 

 
4 Dans un mix traditionnel sur vinyles, le DJ joue sur la vitesse de rotation de ses platines pour obtenir des 

tempos identiques, ce qui entraîne une modification de la tonalité (pitch) de ses sons. MIXVIBES


  vous permet 

de changer le tempo d’un son sans en modifier la hauteur (voir p. 17). 
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Lecteur A 

Lecteur B 

Tranche de console B 

Tranche de console A 

Rack de volume 

B. Rack de Volume : Masterisation et Enregistrement 

 

Selon que vous utilisiez un ou deux périphériques audio, vous 

disposez d’un ou deux racks de volume, correspondant chacun à 

une sortie audio. Si vos deux lecteurs sont réglés sur la sortie 

01 dans leur tranche de console respective, vous obtiendrez 

votre mix sur le premier rack de volume. 

 

 

1. Masterisation 

 

Le rack de volume vous permet de masteriser le signal audio en provenance du ou 

des lecteurs source. Cette piste master regroupe les mêmes contrôles que la tranche de 

console d’un lecteur : une égalisation globale peut, par exemple, être définie pour votre 

mix. 

 

 

 

 

 

 

 

 

 

 

 Le signal de sortie visualisé sur le vu-mètre ne devrait jamais atteindre le maximum 

même lorsque le curseur de volume est lui à son maximum (voir ci-après). Si c’est le cas 

revoir le réglage du gain au niveau des tranches de console (voir p.19).  

Egaliseur 
3 bandes 

Suppression de 
fréquences 

Master Volume 

Vu-mètre du Master Volume 

Master Panoramique 
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2. Enregistrement 

 

Il vous est également possible d’enregistrer vos propres performances, sous le format 

d’un fichier « .wav ». Cliquez simplement sur le bouton d’enregistrement dans le Volume 

Rack de votre choix puis désignez le nom et l’emplacement du fichier audio qui sera créé 

avec votre mix. Voilà, l’enregistrement est lancé ! Cliquez une nouvelle fois sur le bouton 

d’enregistrement pour y mettre un terme. 

 

 

 Gardez un œil sur le vu-mètre du volume d’enregistrement pour vous assurer que 

l’enregistrement ne sature pas (le signal ne doit pas atteindre la couleur rouge). 

 

 

  

 

 

Volume bien réglé Risque de 
saturation ! 

 
Démarrer/arrêter 
l’enregistrement 

Réglage du volume 
d’enregistrement 

Vu-mètre du volume 
d’enregistrement 
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Médiabase Playlist Explorateur 

Recherche d’un média 

  Chapitre 4 : les médias dans MIXVIBES
 

 

Les chapitres précédents ont présenté les fonctionnalités qui vous seront utiles 

pour effectuer vos mixes avec MIXVIBES


. 

 

Afin d’éviter toute perte de temps dans la recherche de fichiers éparpillés sur 

votre ordinateur, MIXVIBES


  propose des fonctions avancées de gestion des médias. 

Pour gagner en efficacité, pensez à créer une ou plusieurs « médiabases » (bibliothèques 

de médias) et à organiser intelligemment vos playlists (listes de lecture). Vous pourrez 

ainsi sélectionner et glisser-déposer les médias sur les lecteurs directement à partir de 

votre médiabase ou de votre playlist, sans passer par l’explorateur. 

 

A. Médiabase  

 

La médiabase permet, en quelques sortes, de créer une liste de « raccourcis » vers 

vos médias, les rendant plus accessibles que si vous deviez allez les cherchez à leur 

emplacement réel sur l’ordinateur. Une fois que vous aurez bien organisé votre 

médiabase, trouver un média sera une affaire de secondes ! 

 

1. Ajouter un fichier à la médiabase 

  

Glissez – déposez 

simplement votre fichier de 

l’explorateur MIXVIBES


 

vers la médiabase. 

 

 

Les informations du média sont chargées 

automatiquement lors de son ajout à la médiabase. 

 

 



Guide de l’utilisateur 

 26 
 

 

Vous pouvez également si vous le désirez importer tous 

les fichiers contenus dans un répertoire ou un volume de 

votre ordinateur. Effectuez, dans l’explorateur, un clic 

droit sur le dossier ou le volume qui contient vos 

fichiers, puis un clic gauche sur Scan dans le menu 

contextuel. Tous les fichiers contenus dans le dossier ou 

le volume sont automatiquement ajoutés à votre 

médiabase. 

 

 Lorsque vous chargez un média dans un lecteur directement à partir de l’explorateur, 

celui-ci est automatiquement ajouté à la médiabase. 

 

2. Gérer sa médiabase 

 

Comme précisé précédemment, il est possible de gérer plusieurs médiabases. 

 

 Créer : 

Pour créer une nouvelle médiabase (vide), vous pouvez au 

choix : 

• choisir New dans le menu File, 

• cliquer sur l’icône  dans la barre d’outils.  

 

 

 Sauvegarder : 

Une fois que vous avez fini d’organiser votre médiabase, 

sauvegardez-la ! Vous pouvez au choix : 

• choisir Save>MediaBase dans le menu File,  

• cliquer sur l’icône  dans la barre d’outils.  

 

Si vous n’avez jamais sauvegardé votre médiabase, une boîte de dialogue s’ouvre, 

choisissez un nom et une destination pour votre fichier puis cliquez sur Enregistrer. La 

médiabase se présente sous la forme d’un fichier « .vib ». Ce fichier, en plus de lister vos 

médias, archivera également l’état de vos lecteurs ainsi que les repères propres à chaque 

média (point cue, localisations, boucle, etc.). 

 

 Charger : 

Pour charger une médiabase existante, vous pouvez au choix : 

• choisir Open>MediaBase dans le menu File. 

• cliquer sur l’icône  dans la barre d’outils.  

 

 

Une boîte de dialogue s’ouvre, sélectionnez votre fichier « .vib » puis cliquez sur Ouvrir. 
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 Trier : 

Afin de retrouver plus facilement un média dans votre médiabase, vous pouvez trier 

les médias selon certaines propriétés, simplement en cliquant sur le titre de la colonne 

correspondante. Chaque clic sur « Album » triera ainsi par ordre  alphabétique,  

alternativement croissant ou décroissant, les médias selon leur nom d’album.  

 

 Modifier les propriétés d’un média : 

Un clic droit sur un média de la médiabase vous donne accès 

à un menu d’options, qui vous permettra, entre autres, 

d’afficher les informations relatives au média sélectionné en 

cliquant sur Edit. 

 

   

 

3. Importer une bibliothèque iTunes® 

 

Si vous utilisez le logiciel iTunes® d’Apple pour gérer vos médias, vous pouvez 

directement importer votre bibliothèque dans MIXVIBES


 . 

 

Cliquez sur Import file dans le menu File. Une boîte de dialogue apparaît, indiquez 

l’emplacement du fichier5 « .xml » (par défaut « Mes Documents\Ma musique\iTunes\ 

iTunes Music Library.xml ») correspondant à votre bibliothèque iTunes®, sélectionnez-le 

puis cliquez sur Ouvrir. 

 

Tous les médias référencés par iTunes® sont ajoutés à votre médiabase avec leurs 

informations, ainsi que les playlists qui apparaissent sous forme de groupes dans la 

fenêtre Sélection (voir p.30). 

 

Attention il s’agit uniquement d’une fonction d’import, aucune modification 

effectuée  dans la médiabase MIXVIBES


  ne sera prise en compte dans iTunes®. 

 

 

B. Playlist  
 

Une playlist permet de définir une liste de médias qui seront 

enchaînés lors de leur lecture. Une playlist peut être créée 

soit à partir de la médiabase, soit à partir de l’explorateur. 

Pour ce faire, il suffit de glisser-déposer le média dans la 

fenêtre playlist (si le média est en provenance de 

                                                

 

 
5 Le fichier « .xml » doit porter un nom du type « iTunes*.xml » ou « * » représente n’importe quel texte, dans 
le cas contraire MIXVIBES


  refusera de le lire. 
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l’explorateur, il sera automatiquement ajouté à votre médiabase). 

Si vous désirez changer la position de lecture d’un média dans une playlist, sélectionnez-

le et faites-le glisser vers la position qui vous convient. Une ligne bleue vous indique sa 

position de destination. 

 

Une fois que vous avez fini de constituer votre playlist, utilisez les boutons mis à votre 

disposition pour en contrôler la lecture :   

 

 

 

 

 

 

 

 

 

 

 Les playlists utilisées dans MIXVIBES


 sont importables/exportables au formats 

« .m3u » et « .txt », exportables au format « .lst », et donc compatibles avec la plupart 

des lecteurs multimédia du marché. 

 

1. Importer une playlist : 

 

Pour importer une playlist  existante, cliquez sur Import file dans le menu 

File. Une boîte de dialogue apparaît, indiquez l’emplacement du fichier que 

vous souhaitez charger, sélectionnez-le puis cliquez sur Ouvrir. 

 

 

2. Sauvegarder votre playlist : 

 

Pour exporter votre playlist, cliquez sur Export file dans le menu File. Il ne 

vous reste plus qu’à choisir un type, un nom et une destination pour votre 

playlist et à cliquer sur Enregistrer. 

 

 

3. Modifier la playlist : 

 

Un clic droit sur un média de la playlist affiche un menu contextuel 

d’options, qui vous permet, entre autres, de le retirer de la playlist (clic 

sur Delete). Le média restera bien entendu toujours accessible dans votre 

médiabase.  

 

 

 

Stoppe 
tous les 
lecteurs 

Stoppe la 
lecture de 
la playlist 

Lance 
la 

lecture 
de la 

playlist 

Active/Désactive 
la répétition de la 

playlist 

Active/Désactive 
le mode aléatoire 

Recherche rapide 
arrière/avant 

dans le média de 
la playlist en 

cours de lecture 

Média 
précédent/suivant 
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C. Recherche 

 

 

 

 

 

 

Dès lors que vous avez constitué une médiabase conséquente, la méthode la plus rapide 

pour retrouver un média dans la médiabase est sans doute d’utiliser la fonction 

Recherche de MIXVIBES

. 

 

: Recherche exacte. Cliquez sur ce bouton pour l’activer ou la désactiver. Une fois 

activée, votre recherche n’aboutira que si une propriété (Title, Artist, ..) du média 

recherché débute de la même façon que le texte tapé dans le champ de recherche. 

 

: Affichage dans la playlist. Cliquer sur ce bouton pour l’activer ou le désactiver. Une 

fois activé, le résultat de votre recherche s’affichera dans la fenêtre playlist et non plus 

dans la fenêtre médiabase. 

 

Cette liste de critères vous permettra d’orienter la recherche MIXVIBES


 vers 

une unique propriété (Title, Artist, etc.). Par défaut, ce critère est inactif (All), la 

recherche s’effectue donc sur l’ensemble des informations des médias. 

 

Exemple d’utilisation : 

 

Vous cherchez un morceau dont vous ne connaissez que le nom de l’album dont il est 

issu ? 

Tapez ce dont vous vous rappelez dans le champ de recherche. MIXVIBES


 se charge 

alors de filtrer intelligemment tout ce qui pourrait être l’objet de votre recherche, et vous 

l’affiche dans la médiabase au fur et à mesure que vous remplissez le champ de 

recherche. 

 

 

N’oubliez pas de vider le champ de recherche lorsque vous n’en avez plus besoin, 

tant qu’il y aura du texte, vous n’aurez pas accès à la totalité de votre médiabase !  

 

 

Recherche 
exacte 

Affichage des 
résultats dans la 
fenêtre Playlist 

Champ de 
Recherche 

Choix du critère 
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D. Fenêtre Sélection  

 

1. Sélection basée sur les champs d’informations de la médiabase 

 

Pour afficher cette fenêtre, cliquez sur Window>Selection. 

 

La fenêtre sélection propose un ensemble de filtres permettant de « trier » les médias 

affichés dans la médiabase et de n’afficher que ceux qui respectent un certain critère 

(les critères ne sont pas cumulables). Par défaut MIXVIBES


  propose des filtres basés 

sur les différentes informations6 des médias (titre, auteur, etc.).  

 

Le filtre All permet d’afficher toute la médiabase. 

 

Pensez à cliquer sur All lorsque vous n’utilisez plus les sélections ! Le filtre 

sélectionné reste actif jusqu’à ce que vous le fassiez, même si vous fermez la 

fenêtre Sélection. Dans le cas contraire, vous risquez de ne plus retrouver (à 

l’affichage uniquement) vos médias. 

 

Le filtre Author permet par exemple de filtrer la médiabase en fonction des auteurs. 

Cliquez sur la croix  située devant Author pour développer la catégorie « auteur », 

MIXVIBES


  vous propose tous les auteurs existant dans votre médiabase. Cliquez sur 

l’auteur qui vous intéresse, seuls les médias dont l’auteur correspond restent affichés 

dans la médiabase. 

  

 

 

 

 

 

 

 

 

 

 

 

 

                                                

 

 
6 Excepté Last play, Comment, Track, File name, Date creation, Label, Producer, Key 

Médiabase filtrée 

Fenêtre 
Sélection 

Médiabase complète 
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Les filtres Album, Genre, Rating, Remix, Year, Directory se présentent de la 

même façon que le filtre Author.  

 

A l’inverse, certains filtres ont une apparence particulière.  

 

Développez le filtre Title, par exemple, MIXVIBES


  ne vous propose que les différents 

premiers caractères de champ Titre7 trouvés dans la médiabase. A partir de là, le 

fonctionnement est identique aux filtres précédents, si vous cliquez sur la lettre « A » 

par exemple, seuls les média dont le titre est du type « A... » (« ... » représentant 

n’importe quel texte) sont conservés dans l’affichage de la médiabase. Le filtre File7 

se présentent de la même façon que le filtre Title. 

 

Développez le filtre Bpm, MIXVIBES


  vous propose des intervalles de tempos. 61-80 

permet, par exemple, d’afficher uniquement les médias dont le tempo est compris 

entre 61 et 80 BPM (inclus). -60 permet d’afficher uniquement les médias dont le 

tempo est inférieur à 60 BPM (inclus), 151- uniquement les médias dont le tempo est 

supérieur à 151 BPM (inclus). Sur le modèle des filtres précédents, il propose aussi 

tous les tempos répertoriés dans votre médiabase. Vous pouvez ainsi retrouver les 

média correspondant à un tempo précis ou simplement à une gamme de tempos. 

 

 Les tempos stockés dans la médiabase sont des valeurs au dixième près, le filtre 

sur les tempos ne considère que la partie entière de ces tempos, ainsi un filtre sur 120 

BPM conservera autant les médias à 120.0 BPM qu’à 120.9 BPM. 

 

Développez le filtre Duration, MIXVIBES


 vous propose des nombres entiers de 

minutes, basés sur les durées répertoriées dans votre médiabase. 3 mn permet, par 

exemple, d’afficher uniquement les médias dont la durée est comprise entre 3 (inclus) 

et 4 minutes (non inclus). 

 

2. Les groupes 

MIXVIBES


  vous permet de créer vos propres sélections appelées groupes (groups) à 

l’instar des bacs à disques vinyles utilisés par les DJ. Ces groupes sont disponibles 

dans la fenêtre sélection, comme n’importe quel filtre, à la différence près qu’ils 

n’effectuent aucun filtrage des médias sur leurs informations mais affichent 

simplement les médias que vous y aurez associés. 

 

 Créer un groupe 

Pour créer un nouveau groupe, cliquez avec le bouton droit de la souris sur le filtre 

Groups puis avec le bouton gauche sur Add group dans le menu contextuel qui 

apparaît. Une fenêtre Add Group s’ouvre, tapez-y le nom que vous souhaitez donné à ce 

                                                

 

 
7 En effet, il est plus rare d’avoir deux titres ou deux noms de fichiers identiques, il est donc plus judicieux de 
se baser sur le principe de l’index alphabétique. 
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nouveau groupe (par ex. « Mon Groupe ») puis pressez la touche [Entrée] de votre 

clavier. Un nouveau groupe apparaît dans la fenêtre sélection au niveau du filtre 

Groups : 

 

 

 

 

Cliquez sur votre groupe, remarquez qu’aucun média ne s’affiche dans la médiabase. Il 

vous faut désormais le remplir ! Pour ce, commencez par cliquer sur All pour réafficher 

toute votre médiabase. Sélectionnez ensuite les médias8 que vous souhaitez mettre dans 

votre groupe fraîchement créé et glissez-déposez-les sur le nom de ce dernier. Le 

pointeur de souris      vous indique que vous pouvez les y déposer. Faites-le :  

 

 

 

 

 

 

Vous pouvez aussi ajouter des fichiers à votre groupe en les sélectionnant dans la 

médiabase puis en cliquant, dans le menu contextuel obtenu par un clic croit, sur son 

nom dans Group>Add Selected Items in group. 

 

Cliquez ensuite sur le nom de votre groupe pour en afficher le contenu et admirez le 

résultat ! Seuls les médias que vous avez « rangés » dans ce groupe s’affichent. 

 

 Modifier un groupe 

 

Vous pouvez, si vous le désirez, retirer certains médias de votre groupe. Pour celà, 

sélectionnez le(s) média(s) concerné(s) dans la médiabase puis cliquez sur 

Group>Delete Selected Items in group. 

 

Si vous supprimez les médias à l’aide de Edit>Delete, vos médias sont supprimés 

de la médiabase et pas seulement du groupe que vous affichez. 

 

 Renommer un groupe 

 

A tout moment, vous pouvez changer le nom de votre groupe. Pour cela, cliquez avec le 

bouton droit sur le nom de votre groupe, dans la fenêtre Sélection puis choisissez Edit 

name dans le menu contextuel. Tapez le nom qui vous convient puis validez en pressant 

la touche [Entrée] de votre clavier. 

 

                                                

 

 
8 Maintenez la touche [Ctrl] de votre clavier enfoncée pour effectuer une sélection multiple. 
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 Supprimer un groupe 

 

Si vous n’utilisez plus un groupe, vous pouvez le supprimer en cliquant sur Delete 

group dans le menu contextuel (obtenu par un clic droit sur son nom dans la fenêtre 

Sélection). 
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Affiche/Masque 
l’explorateur 

Affiche/Masque la 
médiabase Affiche/Masque la 

playlist 
Affiche/Masque le 

crossfader 

Affiche/Masque le 
rack de volume 

Affiche/Masque le 
rack Auto BPM 

Chapitre 5 : Personnaliser son espace de travail 

 

MIXVIBES
 
vous donne la possibilité d’organiser votre espace de travail en 

fonction des éléments dont vous avez besoin. Ces préférences sont systématiquement 

enregistrées à la fermeture du logiciel. Ainsi, à chaque lancement de MIXVIBES

, vous 

retrouvez automatiquement votre interface personnalisée, telle que vous l’aviez laissée 

lors de votre précédente utilisation. 

 

 

A. Affichage/Masquage des éléments MIXMIXMIXMIXVIBESVIBESVIBESVIBES

 

 

Vous pouvez choisir d’afficher ou de masquer les différents éléments graphiques 

de l’application (outre les lecteurs) à partir des boutons d’affichage que vous trouverez 

dans la barre d’outils (ou dans le menu Window) : 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exemple d’utilisation : 

 

Une fois que vous avez complété votre médiabase, les médias que vous utilisez sont 

directement disponibles dans votre médiabase, vous n’avez a priori plus besoin d’afficher 

la fenêtre de l’explorateur. Désactivez son affichage en cliquant sur l’icône  afin de 

laisser plus de place à l’affichage des colonnes de la médiabase et de la playlist. 

 

 

 

 

 

 

 

B. Taille des éléments MIXMIXMIXMIXVIBESVIBESVIBESVIBES
   
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Maintenez enfoncé le bouton gauche 

de la souris et déplacez la jointure... 

... et relâchez le bouton 

lorsque la position vous 

convient. 

 

Il vous est également possible de modifier la taille de certains éléments de l’interface 

(fenêtres de gestion des médias : médiabase, playlist et explorateur). 

 

Approchez le pointeur de la souris de la jointure des deux fenêtres dont vous souhaitez 

répartir les dimensions. Lorsque le pointeur  se transforme en  , maintenez enfoncé 

le bouton gauche de votre souris et déplacez la jointure horizontalement jusqu’à obtenir 

les dimensions de votre choix. 

 

Exemple d’utilisation : 

 

Vous souhaitez avoir une fenêtre médiabase conséquente afin de visualiser au maximum 

les informations relatives à vos médias, tout en réduisant la fenêtre playlist. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C. Affichage des informations dans la médiabase :  

 

Il vous est possible de modifier l’affichage de votre médiabase. Vous pouvez ainsi 

choisir d’afficher ou de masquer chaque colonne (Title, Author, Album, etc.) comme bon 

vous semble mais aussi en modifier l’ordre. Pour ce : 

 

- effectuez un clic droit sur le titre d’une colonne, 

 

 

- le menu Columns Properties apparaît, sélectionnez les 

colonnes désirées, modifiez l’ordre d’affichage avec les 

boutons Up et Down puis validez en cliquant sur OK. 
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Chapitre 6 : Présentation des menus 
 

A. Menus Principaux 

 

1. Menu File 

New : permet de créer une nouvelle MédiaBase. 

Open > Mediabase : permet de charger une médiabase 

(« .vib ») préalablement sauvegardée. 

Open > Sequence : permet de charger une séquence 

(« .vsq ») préalablement sauvegardée.  

Open > Music : permet d’ouvrir un fichier audio et de l’ajouter 

dans la médiabase. 

Save > MediaBase : permet de sauvegarder une médiabase 

afin de la retrouver ultérieurement. 

Save > Sequence : permet de sauvegarder une séquence 

(fichier « .vsq ») afin de la retrouver ultérieurement.  

Save As... : permet de sauvegarder une médiabase sous un 

nom différent afin de la retrouver ultérieurement. 

Import file : permet d’importer des playlists à partir de fichiers 

« .m3u » ou « .txt » ou une bibliothèque iTunes® « .xml ». 

Export file : permet de sauvegarder une playlist au format 

« .m3u », « .txt » ou « .lst ». 

Scan : permet de rechercher tous les médias dans un répertoire de votre disque dur 

pour les importer directement dans votre médiabase. 

1 mediabase1.vib : Nom de la dernière médiabase chargée, celle actuellement utilisée. 

2 mediabase2.vib : Nom de la précédente médiabase chargée au cours de la session. 

Options : Donne accès aux options de configuration du logiciel. 

Properties : Affiche les propriétés de la médiabase. 

Config Report : Génère un rapport de configuration. 

Quit : Ferme MIXVIBES
. 

Reset : Stoppe immédiatement les lectures en cours et vide les lecteurs de leur média. 

 

 

2. Menu Edit 

Delete : retire le(s) média(s) sélectionné(s) de la médiabase. 

Edit : permet d’éditer les informations relatives au média 

sélectionné dans la médiabase (notamment les tags). 

Find : permet de rechercher un média dans la médiabase. 

Select All : sélectionne la totalité des médias contenus dans la 

médiabase.  
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3. Menu Media 

 

Toutes ces commandes s’appliquent uniquement au(x) média(s) sélectionné(s) dans la 

médiabase.  

 

Play : effectue le chargement (si nécessaire) et la lecture du 

média dans la platine active. 

Stop : met la lecture des médias en pause. 

Forward : permet d’avancer dans la lecture du média. 

Backward : permet de reculer dans la lecture du média. 

Remove file : supprime les médias sélectionnés de la 

médiabase ainsi que leurs fichiers sur le disque dur. 

Change path : permet de changer le chemin d’accès 

(répertoire sur le disque dur) des médias sélectionnés. 

Save ID3 tag : permet de sauvegarder toutes les 

informations d’un média au sein de son fichier s’il est au 

format « .mp3 ». 

Save Info : Sauvegarde les informations du média au 

format MIXVIBES


  dans un fichier « .vof ». 

Load Info : Charge les informations du média à partir de 

son fichier « .vof » (s’il existe). 

Beat Counting Manual : ouvre l’assistant de calcul manuel du tempo. 

Analyse : analyse les médias (estimation des tempos et calcul des pics).  

Beat Matching : permet de modifier le tempo auquel seront joués les médias à leur 

prochain chargement dans un lecteur. 

 

4. Menu Mix 

 

Play : lance la lecture de la playlist. 

Stop : arrête la lecture de la playlist. 

Forward : charge et lit le morceau suivant de la playlist. 

Backward : charge et lit le morceau précédant de la playlist. 

Add to mix : ajoute à la playlist le(s) media(s) sélectionné(s) 

dans la médiabase. 

Security : active le verrou de sécurité qui permet d’éviter le 

chargement d’un média dans un lecteur lorsque ce dernier est 

déjà en lecture. 

Generate Cue Sheet : permet de générer un fichier de Cue à 

partir de la playlist. 

Save in wav : permet d’exporter la playlist en un fichier audio au format « .wav » 

contenant le mix entier. 
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5. Menu Window 

 

Media : affiche/masque la médiabase. 

Playlist : affiche/masque la playlist. 

Explorer : affiche/masque l’explorateur. 

Selection : affiche/masque la fenêtre de sélection. 

CrossFader : affiche/masque le rack du crossfader. 

Main Volume : affiche/masque les racks de volume. 

Auto Bpm Wnd : affiche/masque le rack Auto-BPM. 

Full Screen : bascule l’affichage en mode « plein écran ». 

 

 

 

B. Options 

 

1. Onglet General  

 

 

 

 

ToolTips : active/désactive les info-bulles contextuelles qui apparaissent lorsqu’on 

déplace la souris sur les boutons/éléments MIXVIBES
.  

Windows caption : affiche/masque la barre de titre des fenêtres de gestion des 

médias et autorise/interdit une réorganisation avancée des différentes fenêtres.  

Scroll title : active/désactive, dans les lecteurs, le défilement du nom du 

média chargé quand celui-ci est trop long pour être affiché entièrement. 

Keyboard quick search : Active la recherche rapide dans la médiabase. 

 

 

 

 

 

Autoload last file / Init Dir : permet de charger automatiquement la dernière 

médiabase utilisée au lancement de MIXVIBES
 en cochant la case  et définissant son 

chemin d’accès. Cela peut s’avérer très pratique si vous utilisez toujours la même 

médiabase… 

Tag : permet de choisir quelle version de tag ID3 (stockage des informations d’un 

média dans son fichier « .mp3 ») on souhaite utiliser, cocher ID3V1 pour les tags 

version 1, ID3V2 pour les tags version 2.  

History : permet de conserver un historique de tous les médias utilisé durant une 

session MIXVIBES
. Il est possible de le consulter/modifier directement avec le Bloc-

notes Microsoft® en cliquant sur See File. 
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Pitch bend : intensité du pitch bend9. 

Speed : permet de régler les valeurs extrêmes des modes vitesse/tempo. 

  Ex : Speed = 10 � variation de ± 10% maximum. 

Jog : permet de régler l’intensité maximum du pitch bend
9
 effectué avec le jog 

wheel. 

Pitch tones : permet de régler les valeurs extrêmes du mode tonalité (en demi-tons) 

Ex : Pitch tones = 6 � variation de ± 6 demi-tons (½ octave) maximum. 

Reverse speed sliders : active l’inversion des curseurs de vitesse/tempo/tonalité 

afin d’obtenir un fonctionnement similaire aux platines vinyles (« norme » chez les 

DJ). Lorsque cette case est cochée, l’augmentation du paramètre 

vitesse/tempo/tonalité s’effectue en baissant le curseur, la diminution en le montant. 

 

 

 

 

Load Time : permet de choisir le type de chargement souhaité. 

Multi instance : autorise l’ouverture de plusieurs MIXVIBES


 en même temps. 

Load memory time limit : permet de définir la durée maximale (en minutes) de 

données audio que MIXVIBES


 est autorisé à stocker en mémoire vive (RAM) 

lorsqu’un média est chargé dans un lecteur dont l’option Load in Memory est 

activée. 

 

 

 

Vol range (db) : permet de régler la course des curseurs de volume, en dB 

(décibels).  

Ex : Vol range (db) = 35 � l’écart entre le volume minimum et le volume maximum 

est de 35 dB (-35dB à 0dB). 

Peak Directory : permet de choisir un répertoire autre que le répertoire par défaut 

(«C:/Program Files/MixVibesHOME/Peak ») pour stocker les fichiers pics (« .vpk »). 

 

 

 

 

 

 

 

 

                                                

 

 
9
 Modification temporaire du paramètre vitesse / tempo / tonalité à l’aide du jog wheel ou des boutons -/+. 
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2. Onglet Mix   

 

 

 

 

 

 

 

 

Bpm min/max : permettent de définir la gamme de valeurs autorisées pour la 

détection du tempo lors de l’analyse d’un média. En effet, l’algorithme de  détection 

du tempo peut rencontrer des difficultés à différencier deux tempo multiples l’un de 

l’autre (60 BPM et 120 BPM par exemple). Dans ce cas, MIXVIBES


  choisira la seule 

valeur comprise dans l’intervalle de valeurs autorisées, à savoir, ici, 120 BPM. 

 La détection du tempo est d’autant plus efficace que la gamme de valeurs est 

réduite. Ne négligez pas ce paramètre. Tous les styles de musiques ont des tempos 

« classiques » ou couramment  utilisés, vous pouvez facilement trouver des 

informations à ce sujet sur Internet. 

Auto Mix When press Auto Match Button : active/désactive le calage temporel 

automatique lorsqu’un bouton de synchronisation du tempo est pressé (voir p. 21). 

Calculate Bpm/Peak at Load : active/désactive le calcul du tempo et des pics d’un 

média lors de son chargement sur un lecteur. Cette option rend le chargement d’un 

média plus lent. En fonction de votre matériel (rapidité du processeur, quantité de 

mémoire vive), elle peut entraîner des saccades dans la lecture audio et/ou dans 

l’affichage durant le chargement. 

Remarque : le calcul des pics est indispensable à l’utilisation des fonctions de 

synchronisation automatique du tempo (voir p. 22) 

Auto Gain adjustement : active/désactive le réglage automatique du gain au 

chargement d’un média (permet d’éviter la saturation au niveau du lecteur). 

 

 

 

 

 

Auto cue No/Yes : Désactive/active le placement automatique du point cue lors du 

chargement d’un média dans un lecteur.  

Search time : intervalle de temps (en secondes, depuis le début du morceau) dans 

lequel MIXVIBES


  va chercher à placer le point cue si l’option précédente est activée. 

Sound detection : seuil de détection en dB (décibels) du point cue. 

 MIXVIBES


  choisira pour point cue le premier instant, dans l’intervalle fixé (ex. 10 

secondes), pour lequel le signal audio dépasse le seuil (ex. 30dB). 
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Fade (sec): durée (en secondes) des fondus enchaînés dans le cas des playlists 

automatisées. 

Warning (sec): temps restant minimum autorisé (en secondes) avant 

déclenchement de l’alerte de fin de morceau. 

 Ici MIXVIBES


 déclenchera l’alerte sur un lecteur lorsque la lecture de son média 

entamera les 10 dernières secondes. 

Loop in bar boundaries : Active/désactive le verrouillage sur le tempo automatique  

des points d’entrée/sortie des boucles. Cette option permet de réaliser des boucles 

quasi-parfaites. 

 

3. Onglet Sound 

 

Ce menu vous permet de définir le matériel audio à utiliser dans l’application 

MIXVIBES
. Vous pouvez également définir le nombre de périphériques ainsi que le 

temps de latence10.  

 

 

 

 

 

 

 

 

 

 

 

 En fonction de votre matériel, un temps de latence trop faible peut altérer la 

lecture des médias. Si vous rencontrez des coupures de son, augmentez 

progressivement la latence jusqu’à ce que le problème soit résolu. Si vous ressentez 

un décalage trop important entre vos actions dans MIXVIBES


  et leur effet sur le son, 

réduisez-la. 

 

 

 

                                                

 

 
10 La latence est le temps de décalage entre le moment où le logiciel demande au matériel de lire un son et le 
moment où ce son est réellement émis. Un matériel professionnel permet d’avoir des latences très faibles 
inférieures à 10ms. En général, seul un utilisateur aguerri pourra être gêné par une latence de l’ordre de 100ms 
qui représente un bon compromis lorsqu’on ne dispose pas d’un matériel haut de gamme. 

Après avoir correctement installé la 

carte son MIXVIBES
 (voir p.7), 

branchez-y un casque audio et 

sélectionnez-la comme deuxième 

périphérique audio. Il vous suffira 

alors de régler un lecteur sur la 

sortie audio 02 pour pouvoir en 

faire la pré-écoute au casque (voir 

p.19). 
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4. Onglet Skins 

 

 

 

 

 

 

 

 

Ce menu vous permet de choisir l’habillage (skin) de votre application. Par défaut, 

MIXVIBES


  ne propose qu’un habillage. Vous pouvez en trouver d’autres sur le forum 

(www.mixvibes.com/forum).  

 

 

 

 

 

 

 

 

 

 

5. Onglet Keyboard 

 

 

 

 

 

 

 

Cet onglet permet de choisir et d’éditer les différentes configurations de raccourcis 

clavier. En effet, MIXVIBES


  vous permet de personnaliser au maximum votre 

interface en adaptant les raccourcis clavier à votre utilisation. Vous pouvez éditer la 

configuration par défaut, soit directement avec le Bloc-notes Microsoft® en cliquant 

sur Edit, soit en passant par l’utilitaire fourni avec MIXVIBES
, que vous trouverez 

sous le nom « MVMapper.exe » dans le répertoire où vous avez installé MIXVIBES


  

(C:\Program Files\MixVibesHOME\MVMapper.exe par défaut), qui vous permet, de 

plus, de créer facilement de nouvelles configurations. 

 

Les fichiers de configuration du clavier portent l’extension « .vkb » et doivent se 

trouver dans le même répertoire que « MixVibesHome.exe ». 

Quelques exemples d’habillages … 
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Chapitre 7 : barre d’outils 
Pour afficher/masquer la barre d’outils, cliquez avec le bouton droit de la souris à droite 
du menu ? et choisissez Commands. 

 

 

Gérer une médiabase. (voir p.25) 

1. Créer une nouvelle médiabase. 

2. Ouvrir une médiabase existante. 

3. Scan : Importer des médias dans sa médiabase à partir d’un répertoire défini. 

4. Sauvegarder sa médiabase. 

 

Contrôler la lecture d’une playlist. (voir p.27) 

5. Stopper tous les lecteurs. 

6. Stopper la lecture de la playlist. 

7. Lancer la lecture de la playlist. 

8. Activer/Désactiver la lecture répétée de la playlist. 

9. Activer/Désactiver la lecture aléatoire de la playlist. 

10. Déplacer la tête de lecture vers l’arrière. 

11. Déplacer la tête de lecture vers l’avant.  

12. Charger et lire le média précédent de la playlist. 

13. Charger et lire le média suivant de la playlist. 

 

Personnaliser l’espace de travail. (voir p.30) 

14. Afficher/masquer l’explorateur. 

15. Afficher/masquer la médiabase. 

16. Afficher/masquer la playlist. 

17. Afficher/masquer le crossfader. 

18. Afficher/masquer le rack de volume. 

19. Afficher/masquer le rack Auto BPM. 

 

Rechercher des médias dans la médiabase. (voir p.29) 

20. Ouvrir le menu Options de MIXVIBES


   

21. Activer le verrou de sécurité qui permet d’éviter le chargement d’un média dans 

un lecteur lorsque ce dernier est déjà en lecture. 

22. Activer/désactiver la recherche stricte. 

23. Activer/désactiver l’affichage des résultats dans la fenêtre playlist. 

24. Champ de recherche. 

25. Choisir le critère de recherche. 

7777    
= 

9999    
= 

11111111    
= 13131313    

= 
15151515    
= 

20202020    
= 

19191919    
= 

17171717    
= 

3333    
= 

1111     
5555    
= 

22224444    
= 

2222    
= 

16161616    
= 8888    = 

18181818    
= 4444    

= 
10101010    = 

6666    
= 

12121212    
= 

14141414    
= 

22225555     22221111    
= 

23232323    
= 

22222222    
= 
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Chapitre 8 : Index 

 
A 

Auto-BPM............................................................ 22 

B 

Barre d’outils ........................................... 26, 34, 44 

Boucle (loop) ..........................11, 12, 14, 16, 17, 26 

C 

Carte son .......................................................... 8, 10 

Charger un média (load) .......................... 11, 13, 15 

Crossfader................................................ 20, 21, 44 

Cue/Stop..................................11, 12, 14, 15, 26, 40 

Curseur speed/master tempo/pitch ........... 12, 17, 18 

E 

Egalisation................................................ 19, 20, 23 

Enregistrement ............................................... 23, 24 

Espace de travail ............................................ 34, 44 

Explorateur..................13, 25, 26, 27, 34, 35, 38, 44 

F 

Fade ..................................................................... 21 

G 

Gain................................................................ 19, 23 

H 

Habillage (skin) .............................................. 16, 42 

I 

iTunes®.......................................................... 27, 36 

J 

Jog wheel ....................................................... 11, 14 

L 

Lecteur MIXVIBES
 .........................11, 12, 13, 14 

Lecture, Pause ...................................................... 11 

Localisation (location) ............11, 12, 14, 16, 17, 26 

M 

Masterisation........................................................ 23 

Médiabase ............................................................ 25 

Menu Edit .................................................27, 36, 42 

Menu File ...............................13, 15, 26, 27, 28, 36 

Menu Media ....................................................37, 38 

Menu Mix .....................................13, 15, 22, 37, 40 

Mute ..................................................................... 19 

O 

Options .........................................13, 15, 20, 36, 38 

P 

Panoramique ........................................................ 20 

Périphérique audio ..............................20, 23, 40, 41 

Pics (peaks) .........................................13, 22, 37, 40 

Pitch/key....................................................17, 22, 39 

Playlist ............................................................27, 38 

Pré-écoute .......................................8, 10, 20, 40, 41 

Propriétés d’un média .......................................... 27 

R 

Raccourcis clavier ................................................ 42 

Recherche............................................................. 14 

Recherche accélérée (search)............................... 14 

Recherche de média (Track search)................11, 29 

Repeat, lecture répétée ....................................11, 14 

S 

Saturation ............................................................. 23 

Sortie audio .......................................................... 20 

Speed...............................................................17, 39 

Suppression de fréquence (frequency kill)........... 20 

T 

Tempo - BPM .12, 14, 16, 17, 18, 21, 22, 39, 40, 41 

Tête de lecture.........................12, 14, 15, 16, 17, 44 

Tranche de console ...................................19, 20, 23 

V 

Volume......................................................20, 23, 24 

Vu-mètre ...................................................19, 23, 24 
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